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1 Introduction 
PicturePlus is the world’s first and only Palm OS JPEG image viewer that makes it possible to 
view and zoom in 100-Megapixel (10,000 by 10,000) JPEG images on a Palm OS device with 
only 300 KB of free memory required.  PicturePlus is ideal for the viewing the following images: 

 Large digital photos captured using high end digital cameras 
 Huge high-way, subway, bus, street maps 
 Digital images created by high-resolution color scanners 
 High quality artwork created by image editing software 
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Major Features of PicturePlus: 

         Unique combination of high compression ratio of JPEG images and fast decoding algorithm 
allows fast viewing of highly compressed JPEG images, including huge maps and high 
quality digital camera images. 
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         Extremely low memory requirement – only requires 300 KB of memory to zoom a 100-
Megapixel JPEG image to 800%. 

         PicturePlus was fully optimized for Palm OS 5.x based devices such as Palm 
Tungsten/Treo/LifeDrive, and Sony Clie devices to achieve lightning fast display speed. The 
entire JPEG decoder engine was written in optimized ARM Native code so that a JPEG 
image of size 640 by 480 can be displayed in half a second on these devices.  

         Standard compliant JPEG decoder implementation guarantees excellent image quality.  

         Thumbnail view allows you to quickly browse through a large number of images.  

         Support 4-bit grayscale, 8-bit color and 16-bit color output.  

         Support Palm and Sony high resolution display. Support Palm Tungsten/LifeDrive and Sony 
dynamic input area and portrait and landscape display modes.  

         Arbitrary ratio zoom support allow easy viewing of huge JPEG images. 

         360 degree drag and move.  

         Beam pictures to other Palm devices.  

         Slide show with configurable delay and loop option.  

         Text notes can be attached to every image (up to 2048 characters).  

         Customizable category support.  

         Seamlessly handle JPEG images stored both in internal memory and on external VFS 
memory cards.  

         Support Palm Tungsten/Treo/LifeDrive 5-way navigator and Sony Clie Jog Dial. 

PicturePlus is shareware and it is priced at $19.95 per copy.  You can try it for free, but if you 
decide to keep it, you must purchase a registration code from us.  Your evaluation license will be 
valid for 15 days.  If you decide to keep PicturePlus after the evaluation license is expired you 
must purchase a registration code from us.  The registration code would unlock your software and 
enable it for unlimited use.  Registered users will receive free software upgrades from us for one 
year.  We also provide registered users free technical support for one year.  You can order 
PicturePlus from our web site at: 
 
http://www.smartcell.com
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2 Installation 
 
Follow the steps below to install PicturePlus on PC: 
 
• Uncompress all files in the ZIP file containing PicturePlus to a folder on your PC. 
 
• Open folder "PC" and double click on the executable file.  This will start the installation 

process for PicturePlus.  Please follow the instructions given by the installation program to 
complete the installation process. 

 
Follow the steps below to install PicturePlus on Macintosh: 
 
• Uncompress all files in the ZIP file containing PicturePlus to a folder on your Macintosh. 
 
• Open folder "Mac" and use your Palm Desktop Install Tool to install PicturePlus.prc. 
 
• If you want to install JPEG images directly to the external memory card, open your Desktop 

Install tool, select the JPEG files to install and specify the "Destination" to be memory card.   
 
• If you want to install JPEG images to internal memory, you must first convert them into Palm 

Database (PDB) format using the PicturePlus Desktop Converter application (you must run 
this on a Windows PC).  Two sample PicturePlus pictures in PDB format are included in the 
ZIP file (earth.pdb and flowers.pdb). 

 
• Perform a HotSync operation to tranfer the PicturePlus application and the pictures to your 

Palm OS device. 
 
If you are installing PicturePlus to a Palm Tungsten T3 device, you also need to install the 
following PRC files: 
 
http://www.smartcell.com/Product/PicturePlus/AppSlipRotate.prc
 
http://www.smartcell.com/Product/PicturePlus/StatusBarLib.prc
 

3 Un-installation 
 
Follow the steps below to uninstall PicturePlus: 
 
• Open Application Launcher (tap on the home icon), and open Menu App>Delete.  Select 

“PicturePlus” from the list and tap on “Delete…”.  Tap on “Yes” to confirm. 
 
• If you have an external memory card or internal drive mode card, you also need to delete the 

following files from the card: 
 

o /PALM/Programs/PicturePlus.prc 
o /PALM/Programs/PicturePlus/PicturePlusDB.dat 
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4 User Interface 

4.1 PicturePlus Main Window 
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In the PicturePlus main window a list of all installed picture files in the current category is shown.  
You can also switch to small thumbnail view mode or large thumbnail view mode.  The list 
includes all PicturePlus files in the current category in internal memory, as well as all PicturePlus 
files in the current category installed on external memory cards.  To change the current category, 
tap on the pop trigger on the top-right corner and a list of categories is shown.  You can also edit 
categories using this popup menu.  To view a picture, select it from the list and tap on the leftmost 
button.  The second button allows you to beam a picture to another device.  The third button 
allows you to view the picture information window.  The fourth button allows you to view and edit 
picture notes.  The fifth button allows you to delete a picture.  The last button starts the slide 
show.  You can also access these functions using the Picture menu.  You can use the “Left”, 
“Right”, "Up", and "Down" buttons to browse the list and press the center button on the 5-way 
navigator or press the Jog Dial to view the selected image. 
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4.2 PicturePlus Picture View Window 
 

 
 
 

 
 
 
Once you tap on the “Picture View” button, the selected picture is displayed in a new window.  In 
this window you can do the following: 
 
• Use the "Down" button to move to the next picture and use the "Up" button to move to the last 

picture.   
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• Tap and drag on the screen to move the picture.   
 
• Press the “Left” button to zoom out. 
 
• Press the “Right” button to zoom in. 
 
• Tap on the bottom right corner of the screen (within 10 pixels from the corner) to bring up the 

picture view toolbar.  Using the toolbar you can select the zoom level, set the image to fit in 
the screen or return to the main window.  

 
• Tap on the "Menu" icon or press the center button on the 5-way navigator or press the Jog 

Dial to return to the main window. 
 
• You can stop the current operation at any time by starting a new operation or simply by 

tapping anywhere on the screen. 
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4.3 Picture Menu 
 

 
 

 
The Picture menu allows you to view, beam, and delete a picture.  You can also use the Picture 
Menu to view information related to a picture, to view text notes attached to a picture, and to start 
a Slide Show.  To open the Picture menu, double tap on the title bar and tap on “Picture”. 
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4.3.1 Beam Picture File 
 

 
 
To beam a PicturePlus file, first select the file from the list, then open the Picture menu and select 
Beam.  You will be asked to confirm whether you want to proceed.  If you wish to continue, tap on 
‘Yes’ and the beaming will start.   
 
You will be informed whether the beaming is successful when the operation is finished. 
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4.3.2 Delete Picture File 
 

 
 
To delete an PicturePlus file, first select it from the list, then open the File menu and select 
Delete.  You will be asked to confirm whether you want to proceed.  If you wish to continue, tap 
on ‘Yes’ and the PicturePlus file will be removed from your device.   
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4.3.3 Picture Information 
 

 
 
To show the Picture Information window, first select a picture from the list and tap on the Info 
button (or use the Picture menu and select Info).  The Picture Information window shows the 
picture category, the width and height of the picture in pixels, picture file size, picture encoding 
format, and picture file location (Internal Memory or VFS card).   
 
To change the category for this picture, tap on the popup trigger and a list of categories is shown.   
Select a category from list or create a new category.  Tap on the “OK” button to save the new 
category information. 
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4.3.4 Picture Notes 
 

 
 

To show the Picture Notes window, first select a picture from the list and tap on the Notes button 
(or use the Picture menu and select Notes).  The Picture Notes window allows you to view and 
edit the text notes associated with the picture.  You can enter a maximum of 2048 characters for 
each picture.   
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4.4 Options Menu 
 

 
 
The Options menu allows you to edit Slide Show options, to edit Zoom options, to specify the root 
directory for VFS picture files, to set passwords, to empty image cache, to register PicturePlus 
and to show version and copyright information about PicturePlus.  To open the Options menu, 
double tap on the title bar and tap on “Options”. 
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4.4.1 Slide Show Options 
 

 
 

This option brings up the Slide Show Options dialog.  The Slide Show Options dialog allows you 
to select whether the Slide Show would run only once or loop till being stopped by the user.  The 
Slide Show Options dialog also allows you to set how long you want each picture to be displayed.   
To accept the settings, tap on the “OK” button.  Tap on the “Cancel” button if you don’t want to 
update the settings.  
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4.4.2 Zoom Options 
 

 
 

This option brings up the Zoom Options dialog.  The Zoom Options dialog allows you to select 
how the initial scale for each picture is determined.  If you choose the “Scale To Fit” option, each 
picture will be scaled so that it can fit in the screen.  If you choose the “Use Last” option, the scale 
you used when viewing the last picture will be used.  The “Use Last” option is useful in Manual 
Slide Show mode.  To accept the settings, tap on the “OK” button.  Tap on the “Cancel” button if 
you don’t want to update the settings.  
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4.4.3 VFS File Directory 
 

 
 

By default PicturePlus will search the default image directory for installed JPEG files.  You can 
also specify it to search in all directories.  However, if you have many files and directories on your 
card, loading of the picture list could be slow.  In this case, you may want to install the JPEG files 
only under a certain directory and its subdirectories.  You can either install them to the default 
directory for image files or create a directory of your own.  If your device uses a memory stick, the 
default directory for image files is typically "/Palm/Images", and if your device uses a MMC or SD 
card, the default directory is typically "/DCIM".  You can use this window to ask PicturePlus to 
only search under the default directory and its subdirectories or to only search under the directory 
of your choice and its subdirectories.     
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4.4.4 Set Passwords 
 

 
 

 
 

You can set a password for each category for protecting the contents of the category.  Once a 
password is set for a category, the user must enter the password to view the pictures in the 
category.  If a password is not provided or the password is not correct, no pictures will be listed 
when the user switch to the category.  The protected pictures will also not be listed under the “All” 
category is no valid password is provided. 
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4.4.5 Empty Image Cache 
 

 
 

PicturePlus stores certain image information to help identify each image and to speed up image 
display speed.  If an external memory card is available, PicturePlus stores this data on the 
memory card under the directory “/Palm/Programs/PicturePlus”.  If no memory card is available, 
this data is stored in internal memory.  If you wish to remove this data to free up memory space, 
you can use this menu option.  However, this operation is not recommended unless you have no 
memory space left, as you will lose the category and notes information for all pictures once you 
delete the image cache.   
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4.4.6 Register PicturePlus 
 

 
 

This option brings up the Register PicturePlus dialog.  The Register PicturePlus dialog shows the 
current license type, the HotSync user name, and the 9-digit Registration Code.  To register, 
enter you 9-digit registration code and tap on OK.  If the code is correct, a confirmation message 
will be shown and your copy of software is then fully functional.  Please note that the registration 
code would not work if the HotSync Username you provide us when you place the order does not 
match the HotSync Username shown in this window.  
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4.4.7 About PicturePlus 
 

 
 
This option brings up the About PicturePlus dialog.  The About PicturePlus dialog shows the 
copyright and version information of the PicturePlus application. 
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5 PicturePlus Desktop Converter 
 
 

 
 

 
The PicturePlus Desktop Converter is a Windows 95/98/2000/NT/XP application that converts 
any JPEG files (*.jpg) to Palm database format (*.pdb).  A converted PDB file has about the same 
size as the original JPEG file. 
 
Follow the steps below to use the desktop converter: 
 
• Start the converter program by double clicking on the Converter.exe file. 
 
• Drag and Drop JPEG files you want to convert onto the list control. 
 
• Click on the "Convert All" button to convert all files. 
 
• Double tap on the PDB files to bring up the Desktop Install Tool to install the PDB files to your 

device. 
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6 How to Contact Us 
 
Web Site  
 
Visit our web site at http://www.smartcell.com for general information and software upgrades. 
 
Questions about Your Order 
 
Send email to sales@smartcell.com. 
 
Technical Support  
 
Send email to support@smartcell.com. 
 
Comments, Suggestions, and Bug Report  
 
Send email to feedback@smartcell.com.  
   
Mailing Address 
 
SmartCell Technology, LLC 
1720 E. Garry Ave., #220 
Santa Ana, CA 92705 
USA 
TEL: (949)838-0089 
FAX: (949)271-4597
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Appendix A - SmartCell Technology LLC Software 
License Agreement 
 
By installing this software you accept all the terms and conditions of the following 
agreement. 
 
This SmartCell Technology, LLC Software License Agreement accompanies the 
PicturePlus(TM) (version 3.10) software product and related explanatory materials 
("Software"). The term "Software" also shall include any upgrades, modified versions or 
updates of the Software licensed to you by SmartCell Technology, LLC.   
 
1. USE OF THE SOFTWARE 
 
• You may use the Software in connection with a single computer system and for the 

number of users and purpose specified by SmartCell Technology, LLC. You may 
distribute the Software in the format as received from SmartCell Technology, LLC 
provided that no modifications are made to the Software. 

 
• You may not distribute the License Information in any form, any copy, or any part of it 

to anyone else; you may not permit the use of the Software or License Information by 
more than the specified number of users; you may not sell, loan, rent, assign, lease or 
sub-license the Software or License Information or any copy or any part of it to anyone 
else; you may not modify, adapt, translate, reverse engineer, decompile, disassemble 
or otherwise attempt to discover the source code of the Software; you may not remove 
any copyright notice, trade mark, legend, logo or product identification of the Software 
or License Information. 

 
2. COPYRIGHT AND TRADEMARK RIGHTS  
 
The Software is owned by SmartCell Technology, LLC and its suppliers, and its structure, 
organization and code are the valuable trade secrets of SmartCell Technology, LLC and its 
suppliers. The Software also is protected by United States Copyright Law and International 
Treaty provisions. You may use trademarks only insofar as required to comply with 
Section 1 of this Agreement, in accordance with accepted trademark practice, including 
identification of trademark owner's name. Such use of any trademark does not give you 
any rights of ownership in that trademark. Except as stated above, this Agreement does 
not grant you any intellectual property rights in the Software. 
 
3. UPGRADE 
 
Upgrades of the software will be made available to you without charge by SmartCell 
Technology, LLC within the first twelve months after you purchase the software.  Free 
upgrades are not available after this twelve months maintenance period.   
 
Requests to change any registration information such as Palm HotSync Username and 
registration code are subjected to review by SmartCell Technology, LLC.  New registration 
information would be given only if there is proof that errors have been made in the 
purchase process.  SmartCell Technology, LLC reserves the right to reject such requests 
if no proof is given.  No changes can be made to the registration information after the 
twelve months maintenance period.      
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4. LIABILITY  
 
SMARTCELL TECHNOLOGY, LLC AND ITS SOFTWARE SUPPLIERS, DISTRIBUTORS AND 
DEALERS MAKE NO REPRESENTATIONS OR WARRANTIES WHETHER EXPRESS OR 
IMPLIED (BY STATUTE OR OTHERWISE) RELATING TO THE PERFORMANCE, QUALITY, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE SOFTWARE OR 
OTHERWISE AND ALL SUCH REPRESENTATIONS AND WARRANTIES ARE HEREBY 
SPECIFICALLY DISCLAIMED AND EXCLUDED. 
 
YOU ALONE ARE ABLE TO DETERMINE WHETHER THE SOFTWARE WILL MEET YOUR  
REQUIREMENTS AND THE ENTIRE RISK AS TO ITS PERFORMANCE IS WITH YOU AND, 
SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU ALONE MUST ASSUME THE ENTIRE 
COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION AND ANY 
INCIDENTAL OR CONSEQUENTIAL EXPENSES. IN NO EVENT WILL SMARTCELL 
TECHNOLOGY, LLC, ITS SOFTWARE SUPPLIERS OR DISTRIBUTORS BE LIABLE FOR (1) 
DIRECT, (2) INDIRECT, (3) SPECIAL, (4) INCIDENTAL OR (5) CONSEQUENTIAL DAMAGES 
(INCLUDING LOSS OF PROFITS OR BUSINESS) RESULTING FROM ANY DEFECT AND 
OR/USE OF THE SOFTWARE, EVEN IF SMARTCELL TECHNOLOGY, LLC HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE, WHETHER DUE TO SMARTCELL 
TECHNOLOGY, LLC'S NEGLIGENCE, BREACH OF CONTRACT, MISREPRESENTATION OR 
OTHERWISE. 
 
NOTWITHSTANDING THE ABOVE, IF THERE SHOULD ARISE ANY LIABILITY ON THE 
PART OF SMARTCELL TECHNOLOGY, LLC BY REASON OF THE LICENSING OR USE OF 
THE SOFTWARE OR OTHERWISE, WHETHER DUE TO SMARTCELL TECHNOLOGY, LLC'S 
NEGLIGENCE, BREACH OF CONTRACT, MISREPRESENTATION OR OTHERWISE SUCH 
LIABILITY SHALL UNDER NO CIRCUMSTANCES EXCEED THE PRICE PAID BY YOU FOR 
THE LICENSE TO USE THE SOFTWARE OR AT THE ELECTION OF SMARTCELL 
TECHNOLOGY, LLC THE COST OF REPAIR OR REPLACEMENT OF THE DEFECTIVE 
SOFTWARE BY SMARTCELL TECHNOLOGY, LLC.  
 
YOU SHALL INDEMNIFY SMARTCELL TECHNOLOGY, LLC AGAINST ALL CLAIMS BY 
THIRD PARTIES (OTHER THAN CLAIMS ALLEGING BREACH BY THE SOFTWARE, AS 
SUPPLIED, OF A THIRD PARTY'S COPYRIGHT, PATENT OR OTHER INTELLECTUAL 
PROPERTY RIGHTS) ARISING FROM THE POSSESSION OR USE OF THE SOFTWARE BY 
YOU OR ANYONE USING IT WITH YOUR CONSENT. 
 
Some states or jurisdictions do not allow the exclusion or limitation of incidental, 
consequential or special damages, or the exclusion of implied warranties or limitations on 
how long an implied warranty may last, so the above limitations may not apply to you. 
 
5. GOVERNING LAW AND GENERAL PROVISIONS  
 
This Agreement will be governed by the laws of the State of California, U.S.A., excluding 
the application of its conflicts of law rules. This Agreement will not be governed by the 
United Nations Convention on Contracts for the International Sale of Goods, the 
application of which is expressly excluded. If any part of this Agreement is found void and 
unenforceable, it will not affect the validity of the balance of the Agreement, which shall 
remain valid and enforceable according to its terms. You agree that the Software will not 
be shipped, transferred or exported into any country or used in any manner prohibited by 
the United States Export Administration Act or any other export laws, restrictions or 
regulations. This Agreement shall automatically terminate upon failure by you to comply 
with its terms. This Agreement may only be modified in writing signed by an authorized 
officer of SmartCell Technology, LLC. 
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6. NOTICE TO GOVERNMENT END USERS  
 
The Software and Documentation are "Commercial Items," as that term is defined at 48 
C.F.R.  .101, consisting of "Commercial Computer Software" and "Commercial Computer 
Software Documentation," as such terms are used in 48 C.F.R.  3.1012 or 48 C.F.R.  
27.7202, as applicable. Consistent with 48 C.F.R.  3.1012 or 48 C.F.R.  27.7202-1 through 
227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer 
Software Documentation are being licensed to U.S. Government end users (A) only as 
Commercial Items and (B) with only those rights as are granted to all other end users 
pursuant to the terms and conditions herein. 
 
Copyright (c) 2002, SmartCell Technology, LLC 
All rights reserved. 
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